
TOPIC 1 : WORD PROCESSING 

Introduction 

There has always been a need to come up with better writing tool to improve on efficiency and 

legibility of the written work.  These tools include manually type writers, electronic type writers. 

ELECTRONIC WORD PROCESSORS 

An electronic word processor is application software documents, 

Examples of common word processors include; Microsoft word, cavil word perfect, lotus word 

pro and apple works. 

WORD PROCESSOR 

Definition:  Is software for preparing formatting and editing of a document. 

Eg: of word processors packages; 

1) Microsoft word 

2) Microsoft works 

3) Apple work 

4) Open office writer 

5) Lotus word pro, 

6) Corel word perfect. 

THE DIFFERENT BETWEEN WORD PROCESSOR AND MICROSOFT WORD 

A word processor is the type of software.  Word processing is what you do with a word 

processor. 

So Microsoft word processor, typing a letter in Microsoft word is word processing. 

BENEFIT OF USING A WORD PROCESSOR OVER TYPEWRITERS 

1) Word processor can save data while typewriters cant 

2) You can edit while you work on a word processor, but with a typewriter you have to start over 

3) Easy to correct mistake while a typewriter cant 

      4) Typewriter also didn’t have features like spell check while word processor has 

 

STARTING MICROSOFT WORD 

There are two alternatives. 

Alternative 1 

Using start button. 

1.Click start button,the menu will appear. 

2.Select all programs 

3.Select Microsoft office,the group menu will appear. 
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4.Double click the Microsoft word 2003-2010 the window will appear. 

 

Alternative 2 

Using keyboard 

1.Pres window logo key. 

2.Select all programs for double click on microsoft word 2003-2010 

NOTE 

If you select  all programs follow procedure 3 and 4 above other wise  

3.The window will appear. 

FEATURES OF A WORD PROCESSOR 

Most word processors have common features.  Each task appears in a rectangular are called 

Application window. 

TITTLE bar 

A title bar indicates the tasks which are currently running on its right.  There are; minimize, 

restore and close button 

Menu bar 

The menu bar provides the user with a group of commands.  Each command has a drop down 

list, when clicked, used to create and manipulate documents 

Tool bar 

Tool bar consist of buttons of command (icons) that provide shortcuts to command available in 

the menu bar.  The two default tool bars are the standard and formatting tool bar.  

DOCUMENT WINDOW 

This is the work area where you create documents.  It is resembled on an ordinary piece of paper. 

STATUS BAR 

The status bar is the communication channel between the user and application program.  It 

displays the current page, section line and activities such as file saving process. 

 Search and replace:  Allows you to direct the word processor to search for a particular word or 

phrase. 

 Print feature :  Allows you to send a document to a printer to get hard copy 

 File management:   Many word processors contain file management capabilities that allow you 

to create, move and search for files. 

 Font specification:  Allows you to change font within a document. 
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 Mail merges:   This is particularly useful for generating many files that have the same format 

but different data.  Generating mailing labels is the classic. Example of using merges. 

 Spell checker:  A features that allows you to check the spelling of words 

 Table of contents and indexes:  Allows you to automatically create a table of content and index 

based on special codes that you insert in document. 

 WYSIWYG (What you see is what you get): With WYSIWYG, a document appears on the 

display screen exactly as it will look when printed. 

OPEN A FILE WITH WINDOW XP 

1) Open word 2007 

2) Click the Microsoft button a menu will appear 

3) Click open, the open dialog box will appear 

4) Use the look in field to move to the folder in which you saved the file.  The file is named 

lesson two docx 

5) Click lesson Two docx 

6) Click open.  The file you create during the previous lesson appears 

ALTERNATE METHOD OPENING A FILE WITH KEYS 

1) Open word 2007 

2) Press Ctrl+O 

3) Locate the folder in which you saved your file.  The file is named lesson two docx. 

4) Click lesson two docx. 

5) Click open. The file you create during the previous lesson appear 

DOCUMENT VIEWS 

• Draft view 

• Web layout 

• Print layout 

• Reading layout 

• Outline view 

  

ADVANTAGES OF WORD PROCESSOR PROGRAMS 

1.       Easier to use due to automated features such as word- wrap, auto correct and auto 

complete. 

2.       They have superior editing tools such as spelling checker etc. hence making editing 

easier. 

3.       Can store documents for future retrieval 

4.       They have superior formatting feature that make a document more appealing to the 

reader 
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•         The user can produce multiple copies more easily 

•         Copy and move (cut) operating making it easier to manipulate documents. 

 

CREATING A DOCUMENT USING MICROSOFT WORD 

Microsoft word, commonly referred to as word, is the most common word processor.  The five 

commonly used versions of word are word 97, 2000, 2002(XP), 2003 and 2007. 

While word 97-2003 look alike and are compatible, word 2007 radically divorces from these 

version in the look and manually out, there is no file menu and once text is highlighted a floating 

formatting tool bar is displayed above the selected text.  More over document saved in 2007 

format cannot be opened in previous version unless you save the file in compatibility mode for 

consistency; we shall use word processing software called Microsoft word 2003. 

 

Typing text 

When typing, once the cursor reaches the end of the current line it automatically jumps to the 

next line.  If one word does not fit in current line it automatically wraps at the beginning of next 

line.  This is referred to as word wrap 

 

Saving file 

1.       On the file menu, click the “save as” command. 

2.       Select the storage location from the “save in” list box 

3.       Type a name of the file in the “file name” box then click “Ok” 

 

EDITING A DOCUMENT 

Making changes or modifying an existing document is called editing, some editing operations 

includes: 

 

Deleting text 

To delete a character, a word or a block of text 

•         Highlight the text to be deleted 

•         Press the “delete” key or the “backspace” key. 

 

Find and replace 
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Find and replace is used to locate a word or a phrase and replace it with another: 

To” find and replace” a word of phrase. 

•         On the edit menu , click find or replace 

•         On the “find what” box , type the word or phrase to find 

•         Click the “replace” icon in the replace box, type the word or phrase to replace the 

target word or phrase. 

 

Spelling and grammar checker 

Spelling and grammar checker automatically locates misspelled words and grammatical 

mistakes. 

To spell check a document 

•         On tools menu bar click spelling and grammar or press F7 

•         In the spelling and grammar dialog bar.  Misspelled words are shown in red while 

grammatically incorrect phrases are in green. 

•         From the suggestion list, select the correct spelling and grammar. 

•         Click change (all) button.  To ignore, click the ignore (all) button. 

LIMITATION OF SPELL CHECKER 

• Names of people and places are not usually included. 

• The same two words in a row may not be detected 

• If a word is spelt incorrectly but used in the wrong context it will not be detected 

• Quality of dictionaries can vary 

 

 

Thesaurus  

The thesaurus allows the user to automatically find words or phrases with similar meaning 

(synonyms) or opposite meaning (antonyms) to the one selected. 

To use the thesaurus 

•         Highlight text 

•         On tools menu, point language then click thesaurus. 

•         Select a synonym or an antonym  
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Autocorrect and auto text 

Auto correct and auto text are used to automatically correct a commonly misspelled word and 

insert a predefined text when creating a document. 

To create an autocorrect or auto text 

•         On the insert menu, point to Auto text, and then click auto text command. 

•         Click the autocorrect or auto text tab and type the autocorrect or auto text. 

•         Click to apply and close the dialog box. 

 

Undo and redo  

Undo reverses the most recently command while redo reverts back to the cancelled action. 

•         Click on the edit menu, click undo or redo.  Alternatively, press ctrl + Z to undo or 

ctrl + y to redo.  

 

FORMATING A DOCUMENT 

Formatting refers to enhancing the appearance of a document. You format text, paragraphs, 

pages, or the entire document. 

 

Text formatting 

We format text by applying different font types, style, size, color and another attributes. 

 

Text font 

To format text font 

-          Highlight the text to be formatted 

-          On the format menu , click font 

-          In the font dialog box , select the font , style , size and color 
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-          Apply other font attributes then click OK 

 

Font dialog box 

Note:   A faster way of applying font formats is by using the formatting tool bar. 

Case  

The cases applied to text are:  lower case, upper case, Sentence case, title case and toggle 

case.    The use of case in these sentences is deliberate 

To change case 

•         Highlight the text 

•         On the format menu , click change case 

In the change case dialog box, select case then click Ok  
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Superscript and subscript 

Superscript appears just above the rest of characters as in cm 2 superscript 

Subscript appears just below other characters as in  H0
2  subscript 

To make text superscript or subscript 

-          Highlight characters 

-          On the format menu click font 

-          On the font dialog box check superscript or subscript 

Paragraph of formatting 

A paragraph is a separate block of text dealing with a single theme and starting on a new line or 

what.  Some of the formatting features you can apply into a paragraph Include alignment , setting 

tabs and indents , drop cap, bullets and numbering , line , spacing , inserting column and page 

breaks. 

Alignment is the arrangement of text relative to the left margin, centre of the page or the right 

margin. The five major alignment options available are the left, center, right, justified and force 

justified. 

To align text 

-          Highlight the text 

-          On the format menu click paragraph. 

-          In the dialog box, select the alignment option then click OK 

Note:  You can apply alignment by simply clicking any of the five alignment buttons on the 

formatting toolbar. 

Line spacing 

You can set the space between line, paragraphs or blocks of text 

To space line 

-          Highlight the lines of text 

-          On the format menu, click paragraphs dialog box. 
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-          In the paragraph dialog box, select the line spacing option from the line spacing list box 

then click the Ok button 

Setting tabs and indents 

Tab refers to definite cursor stop when the tab key is pressed.  Indenting is moving a sentences or 

block of text away from the margin using the tab key. 

To set tabs and indents 

-          On the format menu click tabs 

-          In the tab dialog box , set the tab stop, alignment and leading then click Ok 

-          Press the tab key to increase or the space bar to decrease the indent.  Alternatively click 

the Increase/Decrease indent buttons on the formatting tool bar. 
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Paragraph dialog box 

 

DROP CAP 

A drop cap is a large character in a paragraph that occupies more than one line down. 

To create a dropped cap  

-          Highlight the paragraph you want to begin with drop cap 

-          On the format menu, click drop cap 

-          Click dropped or In margin 
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-          Specify the number of lines & other options then click Ok 

 

BULLETS AND NUMBERING 

Bullets and numbers are used to create ordered lists. 

To add bullets or numbers. 

1.       Highlight the text. 

2.       On the format menu, click bullets and Numbering. 

3.       In the dialog box  displayed, click Bullets or Numbered 

4.       Click bullet or numbering thumbnail you want to apply. 

INSERTING COLUMNS 

Columns subdivided a page into several vertical sections 

To set columns 

1.       Highlight the text 

2.       On the format menu , click columns 

3.       In the columns dialog box enter the number of columns , set the column width then 

click Ok 

PAGE AND COLUMN BREAKS 

Page, section and column breaks are used to force the cursor to move to a new page section or 

Column even before the end of the current. 

To insert a break. 

1.       Position the insertion pointer where you back want to create a break 
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2.       On the Insert menu, click Break 

3.       In the Break dialog box ,set the break type the Ok 

FORMATTING THE ENTIRE DOCUMENT  

Page setup 

Page setup options let you define the paper size, margins and operations. 

To set up a page 

1.       On the file menu , click page setup 

2.       In the page setup dialog box 

Click any of the following. 

•         Margins tab to set up page margins 

•         Paper tab to specify the paper type and orientation 

•         Layout tab to specify the page content layout relative to the margins 

3.       Click OK to apply  the settings                                             

PAGE NUMBERING 

Page numbers are used to organize a large document for case of reference. 

To insert page numbers 

1.       On the insert menu , click page numbers 

2.       In the position box, specify whether to place the page numbers at the top of page 

(header) or at the bottom of the page (footer) 

3.       In the alignment box – specify whether to align page numbers to the left, center or 

right of the page 

4.       If you don’t want a number on the first page, clear the show number on the first page 

check the box then click Ok. 

Note:    click on the format button to specify other page number options such as numbering type 

and font. 

 

HEADER AND FOOTER 

Header are lines of text that appear at the top margin every page or selected pages while footer 

appear at the bottom margin 

1.       On the view menu, click  Header and Footer 
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2.       To create a header, enter text or graphical object in the header area. 

3.       To create footer , click inside the footer area and enter the text or graphical object 

4.       Click CLOSE on the Header and footer tool bar 

 

FOOT NOTES AND END NOTES 

Footnotes and endnotes are used in large documents to explain, comment or provide reference 

for text in a document.  Footnotes appear at the bottom of the page while endnotes appear at the 

end of a section or a document. 

To insert footnote or endnote. 

1.       On the insert menu, point to reference and then click Footnote. A dialog box is 

displayed. 

2.      In the location section , click footnotes or endnotes and specify the location of the 

footnote or endnote 

3.      In the format section, specify the number type start and continuity. 

4.      Click Insert.  

CREATING AND MANIPULATING TABLES 

A table is made up of rows and column of cells. It is used to organize and present information in 

rows and columns 

Creating a table 

To create a table 

1.       Click where you want to insert the table 

2.       From the table menu , point to Insert and then click table 

3.       In the dialog box , set the number of column and rows 

4.       Specify the auto format option if needed to be  

EDITING AND FORMATING A TABLE 

To delete rows or columns  

1.       Select the row 

2.       On the table menu, point to Delete then click Row/column 

To insert rows or columns 

1.       Click the insertion pointer where you want to insert the rows/column 

2.       On the table menu , point to Insert then click Rows/ column  
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To merge cells 

1.       Highlight the cells 

2.       On the table menu, click Merge cells. 

To split cells 

1.       Highlight the cells to split 

2.       On table menu, click split cell 

3.       Enter number of rows or columns 

Performing calculations in a table 

To calculate numerical values in a table, use cell references.  A cell is a cross- section of rows 

and column.  Column is represented by letter, A, B, C.   While rows are represented by 1, 2, 

3…… as shown below: 

 

To perform calculations in a table 

1.       Place the insertion pointer to where you want the result to be displayed 

2.       On the table menu, click formula 

3.       Type a formula in the formula box e.g.  = SUM (A1    .  E1) 

4.       Click Ok 

Note:  You can select a formula from past function list and use ABOVE and LEFT instead of 

typing a formula and using cell references respectively 

 

PRINTING A DOCUMENT 

Word processing is not complete without producing a hard copy.  To print a document 

1.       Preview it by clicking “print preview” on the file menu 

2.       Click print from the file menu 

3.       Select the printer range, number of copies and other options then the dialog  box 

Trouble shooting printing related problems 

Some of the printing problems you may encounter are 
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•         Lack of  two- way communication due to pear installation of the printer software 

(drives) if the printer is off or not connected 

•         Paper jams due to use of poor quality of paper or paper folds 

•         Poor quality print due to poor quality ink or toner used. 

Read the manual that comes with the printer to resolve printing problems\ 

DUPLEX PRINTING 

- This is the process of printing on both sides of the paper.  

  

TYPES OF DUPLEX PRINTING 

1) AUTOMATIC DUPLEX PRINTING 

2) MANUALLY DUPLEX PRINTING 

  

AUTOMATIC DUPLEX PRINTING 

This is the automatic printing on both side of the paper 

• Click the Microsoft office button 

• Click print properties and then 

• Click duplex printing , or two – sided printing 

• Click OK. 

  

MANUAL DUPLEX PRINTING 

Manually printing on both side of the paper 

  

PROCEDURES 

Odd and even pages     

• Click the Microsoft office button and then click print 

• On the option select odd page 

• Click ok 

• After the odd pages are printed , flip the stack of pages over and 
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         Then in the print list, select even pages 

• Click ok  

Using advanced Features of a word processor  

Inserting graphical objects 

You can insert a graphical object such as a picture a clip art or drawing onto your document. 

To insert an object  

1.       On the insert menu, point to picture 

2.       Click on the following options 

•         Click Art 

•         From file 

•         From scanner or camera 

•         Organization chart , Auto shape , WordArt or chart 

3.       Depending on the option selected insert or import the object 

Using styles 

A style is a predefined set of formats that can be applied to a block of text together at once. 

To create a style 

1.       Highlight the text you want to see to create a style 

2.       Apply various formats to the text. 

3.       Click the style box in the formatting bar and type a name for the style 

4.       Press enter to apply the style name 

Note:  You can apply an existing style e.g. Headline1, to highlighted text 

 

Generating a table of contents  and indexes  

A table of contents (TOC) is a list of topics in a document and the pages they appear.  It is placed 

in the first pages of the document.  On the other hand, an index is a list of term used in the 

document and the pages they appear.  It is placed at the back pages. 

In order to generate a TOC, you must first mark entries by defining style 

To generate a table of content 
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1.      Turn to the page you want to insert the table of contents 

2.      On the insert menu to reference and then click Index and tables 

3.      Click the table of contents   tab 

4.       Set the TOC entriesthen click Ok 

SORTING AND FILTERING 

Sorting is a process of arranging items / data in a given order. 

SORTING ORDER 

a)     Ascending order 

- Is the process of arranging data / item from the lowest to the highest. 

E.g.   A-Z OR  0, 1, 2, 3……… 

b)     Descending order 

-  Is the process of sorting data / items from the highest to the lowest. 

E.g.:  Z-A OR ………3, 2, 1, 0 

SORT THE CONTENTS OF A TABLE 

1) In print layout view (Print layout views a view of a document / other object as it will appear 

when you print it.  For example:  Items such as header, foot roles, columns and text boxes appear 

in their actual positions). Move the pointer over the table until the table move handle appear 

2) Click the table move handle to select the table that you want to sort 

3) Under table tools. On the layout tab , in the data group click sort 

4) In t the sort dialog box select the option that you want  

SORT A SINGLE COLUMN IN A TABLE 

1) Select a column that you want to sort 

2) Under table tools, on the layout tab, in the data group click sort, 

3) Under my list has, click header row or no header row. 

4) Click option 

5) Under the sort option , select the sort column check box 

6) Click OK 

MS – WORD CHART 

Define:  Is a graphical representation of the table data / items 

TYPES OF CHART 
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i)   Bar chart 

ii)  Pie chart 

iii) Line chart 

iv) Column chart 

v) Area chart 

STEPS / PROCEDURES   

i)   Open Ms – word office 

ii)   Go to insert tab 

iii)  Select chart under illustrations group 

iv)  In a new dialog box type of chart 

v)   Then click OK 

vi)  Enter data from the imported Ms – excel window 

vii) Then close Ms – excel window 

 

To generate an index you mark the index entries by providing the name of the main entry and the 

cross – reference in your document. 

To generate an index 

1.       Mark the index entries in your document a special XE tag is add to the text. 

2.       Turn to the page you want to insert the index 

3.       On insert menu , point to reference then click Index and Tables 

4.       Click the Index tab 

5.       Set the index properties then click Ok 

Password protecting a document 

To protect a document from unauthorized access or modification use a password.  Since 

password is case sensitive avoid mixed case, preferably use lower case. 

To create a password. 
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1.       On the tools menu, click options and then click the security tab 

2.       Type in a password in the password to open box or the password to modify box 

3.       Set other security options then click Ok. 

Generating merged documents 

Mail merging is the process of generating personalized letters, labels or envelopes by merging 

two files, a main document e.g. Letter envelopes or mailing label with a data sources or 

addressing book.  The three main steps of creating a merged document are: 

 

1.       Create a main document e.g. A formula letter 

2.       Create or get the data source i.e. the address book 

3.       Marge the two files to a new document , printer or e-mail 

To create a merged documents 

1.       On the Tools menu , point to letters and mailings then click Mail merge Wizard 

2.       From the mail merge panel displayed , select the type of document to work on e.g. 

letters 

3.       Click Next at the bottom of the panel to proceed 

4.       The will take you through the six steps of creating a merged document 

Note:  To create a merged document using another revision of word, read it’s on line help. 

 

OPIC:2 SPREAD SHEET 

Sheet is a piece of paper with vertical and horizontal line. 

Spreadsheet allows the operator to enter and to store data in a computer, in a grid format. 

Calculations are made according to the formulate entered. The programme makes changes easily 

and quickly. 

Any entry can be changed and the effect of the change calculated automatically. Entries can be 

numbers for calculation. Entries can be words to form headings or formulae. 

The worksheet of a spreadsheet is divided into a number of sections. 

  i. Column: Line of cells down the worksheet. Each is identified by a letter. The identification 

letters starts with A, B, C.... They go through AA, AB, AC,.....,BA,BB,BC,..... and so on up to 

IV. This gives 256 columns. 

  ii. Row: Horizontal lines cross the worksheet. These are identified by numbers from 1 on wards 

up to 65536. 
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 iii. Row: Horizontal lines cross each other they form a cell. Each cell is identified by a column 

letter followed by a row number. For example the first cell is A1. On the worksheet information 

is fed in cells. Moving about the on the spreadsheet is shown by a cell printer. Current cell is 

indicated highlighted rectangle. There are 256 x 65536 cell in a worksheet. 

 iv. Label: Text entries on the worksheet are called labels. These should be kept to minimum. 

They are normally limited to columns and rows headings only. 

 v.  Status area: The area on the screen display which gives information about the current 

worksheet. The information includes content of the current cell, name of the worksheet formula 

and graphical actions. 

 vi. Cell address: The sell which is currently on use. The combination of row and column 

coordinates make up a cell address. Sometimes is known as active cell or selected cell. 

 vii Range: is the assortment of cells. Referring to all cells between and including the reference. 

It consists of two cell addresses separated by a colon. Eg. For A1:A3 this includes cells A1, A2 

and A3. 

Viii.Union: A union reference includes two or more references. It includes two or more cell addresses 

separated by a comma. E.g. A7, B8, C9 this refers to cells A7, B8 and C9 

 ix. Status area: the area on the screen display which gives information about the current 

worksheet. The information includes the content of the current cell, name of the worksheet 

formula and graphical actions 

Applications of the spreadsheet:  

    i.     Spreadsheet is used in decision making. This is because it presents the convenient method 

of quick investigation of data. 

    ii.    Spreadsheet is also used for records keeping. Eg. Student’s records 

    iii.   Prepare budgets 

    iv.   Plan different activities 

    v.   Create charts for data presentation 

    vi.   Prepare financial statements 

   vii.   Prepare statical data. 

1. Click start 
2. Go to all programs 
3. Go to Microsoft office 
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4. Click Microsoft excel 

 
Close spreadsheet 

Go to the right corner of the bar click close  

  

4. Entering data  

Data is entered into the worksheet by moving the cursor to the appropriate position on the screen, 

clicking the left mouse button to select that cell, and then typing the information required. The 

characters you type will appear in the active cell and on the formula bar. 

When you have finished typing data into a cell you should signal the end of that data in one of 

the following ways: 

• Press the Enter key (the cell below becomes the active cell) 
• Press one of the arrow keys (the active cell move one place in the direction of the arrow 
• Click on the Enter box (marked by a green tick) on the formula bar (the original cell is still the 

active cell). 

The are two basic types of information that can be entered into a worksheet: Constants and 

formulae. 
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The constants are of three types: numeric values, text values, and date and time value. Two 

special types of constants, called logical values and error values, are also recognized by Excel 

but are not discussed in this document. 

Numeric value include only the digits 0-9 and some special characters such as + - E e () . , % / 

A numeric cell entry can maintain precision up to 15 digits. If you enter a number that is too 

long, Excel converts it to scientific notation. For example, if you type 12345678901234567, it 

will be stored as 12345678901234500, and displayed as 1.23457E16. sometimes, although the 

number is stored correctly in the cell, the cell is not wide enough to display it properly. In those 

cases, Excel might show a rounded number or even a string of # signs –just increase the width of 

the column 

A text entry can contain up to 32,767 characters (only 1024 will display in the cell but all will 

shown on the formula bar). If the text you enter will not fit in the particular width of your cell, 

Excel lets it overlap the adjacent cell unless that cell already contains an entry, in which case the 

extra text can be thought of as being tucked behind the adjacent cell. 

5. Creating a simple worksheet  

Instructions are given for creating the worksheet shown below. The first stage is to get the 

correct values in the cells. Later you can make the worksheet more attractive by the use of bold 

text, different alignment and color. 
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5.1.            Entering the data  

1. Click in cell B2 and type 

Twiga secondary school 

2. Press the Enter key (or one of the arrow key). 
3. Click in cell B4 and type 

ID NO. 

4. Press the down-arrow key to move to cell B5 
5. Type 
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Rachel Maingu 

6. Press the down-arrow key and then complete column B as shown above. 
7. Enter the data in columns D, E, F and G (but not H and I) 

  

5.2.            Amending data  

If you are in the process of entering data in a cell and you notice that you have made a mistake, it 

is easy to correct it. Press the Backspace (     ) key to delete a character to the left of the cursor or 

the Delete key to delete a character to the right of the cursor. 

If you want to edit the contents of a cell you dealt with earlier, you should double-click in that 

cell and make the alternations either in the cell itself or on the formula bar. 

If you want to clear a cell of its contents (formula and data), formats, comments or all three you 

can selects that cell with a single click of the left mouse button, select clear from the Edit menu 

and then click on contents F formats, Co comments, or All. 

There are a couple of quick ways of clearing the contents of a cell. The first is to use the right 

mouse button to click in the cell and then select clear contents from the menu that appears. The 

second is to select the cell by clicking the left mouse button and the press the Delete key on the 

keyboard. 

Do not confuse using the Delete key with selecting Delete from the Edit menu. That command 

carries out the more drastic action of removing the entire cell from the worksheet and shifting the 

surrounding cell to fill in the resulting space. 

5.3.            Ranges  

In Excel, any rectangular area of cells is known as a range. The range is defined by the top-left 

and bottom –right corner cell references separated by a colon(:). 

So, B4:D7 represents the range of cells cornered by B4 and D7. 

  

  

5.4.            Copying and pasting  

The text in cell E5:E8 ( in other words E5, E6 and E8) is the same as in the range B5:B8 so you 

can copy that. 

1. Point to cell B5 and hold down the mouse button 
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2. Keeping the button held down, drag the pointer to B8 and then release the mouse button. The 
range B5:B8 will be highlighted. 

3. Click on the copy button on the toolbar (or selected Copy from the Edit menu). 
4. Click in E5 (where you want the copy to be place). 

5. Click the Paste button on he toolbar (or select Paste from the Edit menu). 

In addition, there is a smart tag(the Past Options one) near the bottom right-hand corner of the 

pasted data. 

A smart tag can be: 

• Ignored –it will disappear when you carry out some other action 
• Removed –by pressing the Esc key 
• Used – point to it and click on the down arrow to display several options; select one and press 

the Enter key 

For now, just ignore the Paste Options smart tag and finish the process of entering the data. 

1. Click in any cell to remove the highlighting 
2. Press the Esc key to remove the flashing dotted line (marquee) round the cells you copied. 

Note: selecting non-contiguous ranges  

If you need to select cell that are not contiguous, (ie, ranges that are not necessarily next to each 

other), proceed as follows. 

1. Select the first area of cells 
2. Hold down the Ctrl key while selecting the other areas. 

  

  

5.5.            Adjusting the width of columns  

If the Twiga secondary school text is too wide for columns B try widening those column. 

1. Move the cursor to the division between the areas containing the column names. Note how the 
shape of the cursor has changed to a vertical black line with arrows pointing right and left. 

2. Double –click the left mouse button. 

The column will be widened (if necessary) automatically. 

If you wish to have control over the sizing of the column, it can be done manually. 

1. Move the cursor to the division between the areas containing the column names 
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2. Hold down the left-hand mouse button and drag that column divider the required distance to 
the right 

3. Release the mouse button. 
4. Repeat the process if you want to make fine adjustments. 

  

5.6.            Entering currency values  

If you have column containing amounts of money. You do not have to type the â‚¤ sign, instead 

you can enter the numbers and format the cells as currency later. 

Formatting the cells 

1. Highlight the cells ie F5 to F7 (Point to F5, press the mouse button; while keeping the button 
held down, drag the pointer to F7; release the button.) 

2. Point to the highlighted area and click the right mouse button. 
3. Choose Format Cells window, click on the Number tab (unless it is already selected.) 
4. In the Format cells window, click on the Number tab (unless it already selected). 
5. In the category: box select Currency by clicking on it. 
6. Make sure that Decimal places: is set to 2; symbol: show â‚¤ and that the first option in the 

Negative numbers: box is highlighted. Sample: shows you what the result of the formatting will 
be (â‚¤0.50). 

7. Click on Ok. 

Alternatively, you could have formatted the cell first and then entered the values. 

If you begin a numerical entry with a â‚¤ sign, Excel assigns currency format to that cell. 

Similarly. If you end a numerical entry with a % sign, Excel assigns Percentage format to that 

cell. 

Note: Excel 2003 includes the Euro symbol € for currency. 

5.7.            Formatting a cell before entering a value 

Now try formatting a cell before entering its value. 

1. Click in F4 

2. Click on the Bold and Align Right buttons. The cell will not look any different until you 
enter a value 

3. Type 

Costs  

And press the Enter key. 

The text should be in a bold front and right-aligned in the cell. 
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5.8.            Formatting text  

You have entered all the data you need but you might like to make the worksheet easier to read 

by formatting some of the text. 

First make the word Allocation bold. 

1. Click in B4. 

2. Click on the Bold button on the toolbar. 

Next apply a bold font to Adult in C4 and child in D4 and center the text in the cells as follows: 

1. Highlight cells C4:D4 
2. On the toolbar, click on the Bold, italic and Center button. If you can’t remember which those 

are, try pointing to each button in turn –a small pointer message will appear showing its name. 

Next apply a bold italic font to Adult in C4 and Child in D4 and center the text in the cells as 

follows 

1. Highlight cells C4:D4 

2. On the toolbar, click on the Bold, Italic and Center buttons. If you can’t remember 
which those are, try pointing to each button in turn                               

--a small pointer message will appear showing its name. 

5.9. Using different sizes and colors  

The charity Barbecue heading of this worksheet can be made more interesting by changing its 

size and colour. 

1. Click in B2. 
2. Click on the down-arrow of the Font Size button 
3. Select another size, for example, 12. 

    Your text in B2 will increase in size. 

4. Click on the down-arrow of the Font color button. 
5. Select a suitable colour for your text. 

It is possible to colour the background of cells and to centre a heading across a range of cells. 

1. Highlight the cells B2:F2 

2. Click on the down-arrow of the Fill color button. 
3. Select a suitable colour for your background. Be sure to make it different from the colour of 

your text or you will not be able to see the heading! 
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4. Make sure that the range B2:F2 is still selected and click on the Merge and center button. Your 
heading will be centered in that range of cells. 

5. Click in any cell away from the heading. 

5.10 Naming a sheet  

The information on sheet 1 might refer to Twiga Secondary School to be held in Term II. It 

would make sense to name the sheet accordingly. 

1. Right –click on the tab sheet 1  
2. Select Rename from the menu that appears 
3. Type 

Term II 

And press the Enter key (or click in a cell). 

Adding a border  

Sometimes a worksheet can be made more attractive by adding borders around cells. 

1. Select the rectangle of cells starting with B2 in the top left-hand corner across to F7 in the 
bottom right-hand corner. 

2. Click on the down-arrow to the right of the Borders button on the toolbar 
3. Click on the second example in the third row (All Borders). This shows borders around all the 

cells. 
4. Click on a cell not currently selected (to remove the highlighting). 

Another way of adding borders is to select Cells from the Format menu and click on the Border 

tab. First select a style for a line, then apply it by clicking the presets, preview diagram or 

buttons on that Border tab in the Format cells window. This approach gives you more options. 

If you would prefer to draw the border around cells yourself, click on the down-arrow to the right 

of the Borders button on the toolbar and select Draw Borders. On the Borders toolbar that 

appears, select a colour and style for the line, and choose to draw either a grid or just a border. 

Then, just draw on your 

worksheet. An eraser is also available. 

Inserting and deleting rows and columns  

Extra rows and columns can be inserted whenever you wish. As an example, insert a row 

between rows 4 and 5. 

1. Click, with the right mouse button, on the row name 5. 
2. Select Insert (and ignore the Insert Options smart tag). 
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Try inserting an extra column before column A 

1. Click, with the right mouse button, on the column name A. 
2. Select Insert 

To delete a row or column, right-click on its name and select Delete from the menu which 

appears. 

Spell-checking  

Excel allows to check the spelling of your work. You have probably already used this technique 

in word. 

1. Select a cell near the top of your worksheet 

2. Click on the spelling button on the toolbar (or select Spelling from the Tools menu) 

If a spelling mistake is found (or something that Excel thinks is a mistake but isn’t), you will be 

given the opportunity to correct or ignore it. 

Excel will object to Twiga Secondary School. If you wish, change it to Twiga Secondary 

School by editing the text in the Not in Dictionary: box and clicking on the change All button. 

When the end of the sheets is reached, the checking can be continued from the beginning of the 

sheet down to the cell you selected. 

Saving your workbook  

Your workbook can now be stored in a file on a floppy disk (the A: drive)flash, CD or on the 

Networked PC service (the J: drive). 

1. From the File menu select Save As (or Save) 
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A Save As window appears. 

 

 

Choose a name for your file  

1. In the file name: box, type a suitable name (such as Twiga Secondary School) for your file.Later, 
Excel will add the .xis extension automatically. 

Excel file names can have up to 218 characters including alphanumeric characters, spaces and 

the special characters except for ⁄, \ , > ,< ,* , ? ," ,â”‚, ; and : Remember that Excel does not 

distinguish between upper and lower case letters. 

Decide which drive to use  

If you are using the Networked PC service, Excel will offer to save your file one your J: drive 

If you want to save the file to another drive (such as A:) 

1. Click on the down arrow to the right of the Save in: box. 
2. Select the drive of your choice Flash disk (F) 

Note: On the Networked PC service, a quicker way of selecting the A: drive is to click the Flash 

Disk icon at the left –hand edge of the Save As window. 

Decide which folder to use  
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If you want to choose a folder in which to save your file. 

1. Double-click on a folder already displayed in the list box or click the Up One Level button (to 
move up one folder level) and navigate until you can select the folder you want. 

On your own PC, you can click on the History button (at the left-hand edge of the Save As 

window) to see documents and folders you have worked with recently. 

Different file format  

It is possible to save the file in a different file format by changing the setting in the Save as type: 

box. 

Finally  

1. Click on the Save button 

After you save the file, the workbook window remains open and Excel displays the new name in 

the title bar. 

Note: Once a file has been saved for the first time, subsequent changes can be saved by selecting 

Save from the File menu, or by clicking the Save button on the standard toolbar. 

Closing your workbook  

You can close you workbook at any time 

1. From the File menu, select Close  

If you have made any changes to the workbook since it was last saved, you will be asked 

whether you wish to save those changes. 

2. Click Yes to keep the changes or No to discard them (and leave the workbook as it was when 
you last saved it). 

Note: To open the workbook later, select Open from the File menu, navigate to the location of 

the file, select it and click OK. You can have several workbooks open at the same time. 

Calculations 

You can now try doing some simple calculations using a worksheet that was prepared earlier. 

If you are not using the ITS Networked PC service, you may like to get a copy of this file from 

the ITS Web pages before working through the rest of the document. 
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• The file is called Twiga Secondary School.xls and can be found in the information /Guides 
section of the ITS website. 

http://www.dur.ac.uk./its/info/guides/files/excell/). 

Opening a worksheet 

1. From the File menu select Open 
2. Change the Look in: setting to work file on ‘Dudley’(T:). 
3. In the box of folders, double-click on its, and then on Excel. 
4. Click on Twiga Secondary.xls. 
5. Click on Open  

Entering formulae  

All formulae begin with an equals (=) sign. If you forget to type the =, the rest of the line could 

be entered into the cell as a piece of text. Formula can contain values, cell addresses, 

mathematical operators and functions. 

Some of the mathematical operator that can be used are: 

 

  

They are listed here in decreasing order of priority starting with Percent, which has the highest 

priority (done first), and ending with comparison, which has the lowest (done last). If a formula 

contains operators with the same priority, they are evaluated form left to right. 

If you want to alter the order of evaluation, use parentheses (brackets) to group expressions. Any 

parts of a formula that are in parentheses are done first. For example: 

7 + 3/2     will be evaluated as                   8.5 (not 5.0) 

(7 + 3)/2 will be evaluated as                   5.0 
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Entering a formula for total per person  

In this case is the marks of maths, Geog, Chem and Biology 

1. Click in G5 
2. Type = C5 + D5 + E5 + F5 or = SUM (C5:F5) 

Note that you have entered the cell references in the formula, not the values in the cells since 

those particular values might be changed later. 

3. Press the Enter key. 

Have a critical look at the value now displayed in G5. Make sure that it is correct. If it isn’t click 

in G5 and look at the formula displayed on the formula bar. If you find an error in your typing, 

correct it. 

Next copy the formula to cells G6-G13,This will display the total marks for each student of form 

1 in Tanga secondary for the four (4) subjects 

Entering a formula for Average now calculate the average marks for each student in form 

1 for the four subject 

1. Click in H5 
2. Type = (C5 + D5 + E5)/4 or type = G5/4 or 

               Type = AVERAGE (C5:F5) 

3. Press the Enter key. The average marks will be displayed. 

Copying a formula to another cell  

A formula can be copied to another cell in the same way as text or numbers.In this case from h5-

h13 

Sorting  

If you have a rectangular block of data surrounded by blank cells, then Excel recognizes this as a 

list. Data in a list can be sorted alphabetically numerically or chronologically. Excel rearranges 

the rows according to the contents of one or more columns. 

If you select a single cell in the list, Excel will automatically select the whole list for you. If there 

are labels in the first now, excel excludes them from the sort. Alternatively, you can select the 

area of data that is to be sorted. Be careful though, sorting data selected by you does not move 

any non selected data in adjacent columns or rows. 
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On the summer worksheet of the Charity_Barbecue workbook, you have a list in cells 

B13:E19. (If you added extra people, the range will be different) it can easily be sorted by 

surname. 

1. Click on the summer tab. 
2. Click on any name in the Party column 

3. Click the sort Ascending button on the toolbar. 

The list will be sorted in ascending order by name. 

4. Immediately click the Undo button if you want to restore the list to its original order. 

The sort Descending button can be used to sort a list in descending order. 

If you wish to sort by more than one column, select Sort from the Data menu. 

For further information about lists, including sorting, see Guide 36: Lists and data management 

in Microsoft Excel 2003. 

Printing  

There are various stages to getting your information printed 

Page Setup  

1. From the File menu, select Page Setup. 

By changing the options in the Page Setup window, you can control the appearance of your 

printed sheets. This includes choice of margins, headers/footers, page orientation 

(portrait/landscape), scaling, and precisely what will be printed (grid lines for example). 

2. Click on OK in the Page Setup window. 

Print preview  

1. From the File menu, select Print Preview (or click on the Print Preview button on the toolbar) 

In this mode you can, if you wish, view the next/previous page, zoom, use a magnifying glass, 

adjust margins, and change the page breaks. 

2. Click the close button to return to your worksheet. 

Dotted lines will now be displayed on your worksheet indicating page boundaries. 

Selecting a printer and printing your work  
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1. From the File menu, select Print. 
2. If you are working on the Networked PC service, by default, the printout should be directed to 

the printer in the room in which you are working. Check that this is the case. 

If you want a different printer. 

3. Click on the  beside the Printer Name: box 
4. Select the printer you want to use. 

You can specify what is to be printed, which pages are to be printed and (To print your work, 

click on OK) 

GRAPHS AND CHARTS 

Data may be presented in graph or charts as well. 

From the table below 
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To change the colour, click on the bar you want to change the colour. 

If you want to change that chart type,click on the on the chart and insert,select the type of chart. 

                                                                                             

                                                                                

 

PAGE PROPERTIES AND PRINTING  

Includes:- 

1)      PAGE SETUP 

It may include 

a)      Header footer setup 
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b)      Selecting a printer 

c)      Paper layout (page layout) 

  

Procedures 

From the menu bar, click file then select page set up. 

        i.            Page tab 

• On the page tab you may choose either portrait or landscape for the page layout. 
• Select the page size as A4 

      ii.            Header/footer 

• Click header/footer tab 
• Click custom header 
• There are three sections here, you, may type your header in any section depending on what 

type of the paper do you want your footer/header to appear. But in most cases the left section 
is prefered for header. 

• After typing your header click OK. 
• Then click on custom footer. 

The footer may be either in the center section or right section 

• Click on the center section 
• Click the button shown as # the word and page will disappear in the centre section also, data 

and time may be set in the footer right section. After completion of footer and header setup 
click OK> 

PAGE PREVIEW. 

From the Menu bar click File. 

Then select print preview. 

Note: Your page may default to two pages while the document is for one page only. 

Procedures:  

Click page break preview 

Click OK to the window appearing. 

Download this and more free notes and revision resources from https://teacher.ac/tanzania/



If the document is making up two pages, there must be dotted separating those pages. Place your 

cursor on the dotted line and drug it to the right until you meet the solid line 

WORKING WITH MS EXCEL WHILE YOU ARE IN MS WORK  

Select ms excel form tools bar , work with your data 

THE FOLLOWING IS SUMMARY OF PROCUREMENT 

To shift/Return to Ms Excel Double click the Table. 

 

EXERCISE  

From the given data below, 

1. Find, total, Average, and Grades 
2. Draw bar graph, pie chart 
3. Save file name with your name 
4. Put the file in folder, save in desk top an my document 

Formulating the formula  

Note =, the number of opening brackets must be the same as closing brackets  

Example, a student whose average is equal, or greater than 80, is placed in A grade, average 

equal or greater than 70 is grade B, average equal or greater than 50 is in C grade, otherwise F 

grade. 

FORMULA  

=IF(F2>=80,”A”,IF(F2>=60,”B”,IF(F2>=50,”C”,”F”))) 
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EXERCISE 

Banda Enterprises had the following data. 

 
FORMULA: 

Discount=Basic price * Discount 

Basic Price 

VAT=Sale Price* VAT 

Selling price*VAT 
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Selling Price = Sale Price + VAT 

 

Question  

1.Present your information in Chart form (column chart) 

2.Cut the graph and copy it on the separate worksheet and rename worksheet as chart 

3.Create header and footer 

4."Excel test"as header (left section) 

5."You name,Data and time as footer(left section) 

6.Save the work in your name and put it in the folder "on the desktop (My work) 

 

1CHART 

Answer 2 

 

 

Practical work: 

 Manipulation: 

This includes 

I. Mathematical operation (+, -, x, and ÷) 

II. Sum 

III.Average 

IV.Count 

V. Minimum 

VI.Maximum 

VIII.Logical formulae etc 
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When using function, remember the following 

o   Use an equal sign to begin a formula 

o   Specify the faction name 

o   Enclose arguments within parentheses 

o   Use a comma to separate the arguments 

SUM  

The sum function is used to calculate the sums. For example 

=SUM(2, 13, 10, 65) 

In this function: 

The equal sign begins the function 

SUM is the name of the function 

2, 3, 10 and 65 are the arguments 

Parentheses enclose the arguments 

Comma separates each of the arguments 

The other way of using sum function: 

=SUM (A1:A5) 

AVERAGE  

Average function is used to calculate an average from a series of numbers. 

Min(Minimum)  

You can use Min function to find the lowest number in a series of numbers 

Max (Maximum)  

You can use Min function to find the highest number in a series of numbers 

Count 
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The count function is used to get the number of entries in a number field that’s in a range. 

If (logical functions)  

This is conditional formula in a logical manner (true or false). You can use “if” function to group 

or grade the marks/scores/data in a series of numbers. 

Example 1 

 
Example 1 

The following are the form three students score in monthly test. 

 

Represent these marks using: 

a)      Column –chart 

b)      Line chart 

c)      Pie chart 

                                                                Column chart 
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                                                               Pie-chart 
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TOPIC 3: COMPUTER NETWORKS AND 

COMMUNICATIONS 

A network:  

Is a group of two or more devices or people connected to each other so that they can exchange 

information, such as e - mail messages or documents or share resources such disk storage or 

printers. 

Computer network:   

Refers to collections of computing devices that are connected in various ways in order to 

communicate and share resources, usually the connections between computers in a network are 

made using physical wires or cables. However, some connections are wireless using radio waves 

or infrared signals.Networks are systems that are formed by links.The computers may be linked 

or connected to each other in the same building or different buildings. In most cases this 

connection is made via electrical cables that carry the information in the form of electrical 

signals.  The cables transmitting the information are commonly known as transmission Medias 

or Networking media.Networking media is the means by which signals or data are sent from 

one computer to another.  The transmissions media are unshared Twisted Pair (UTP), coaxial 

cable and fiber optic cable.  Whereas Wireless transmission media include radio waves, in folded 

and Bluetooth.When a computer is turned on and can be visible by all other computers then the 

computer is said to be online.  If a computer is not turned on and it is not visible by other 

networked computers, it is then said to be offline. 

Advantage of computer networks and communications 
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1. Networks are all about sharing three things;  Information , resources and applications 

•  Sharing information 

 Allow users to share information in several different ways.  The most common way of sharing 

information is to share individual files.  For example two or more people can work together on a 

word processing document 

•  Sharing resources  

Certain computer resources such as printers or hard drives can be set up so that network users 

can share them .sharing these resources can result in significant cost savings. 

For example:  it is cheaper to buy a single high – speed printer with advanced features that can 

be shared by an entire work group than to buy separate printers for each user in the group. 

•  Sharing applications:  

Several users can work together on a single business application.  For example an accounting 

department may have accounting software that can be used from several computers at the same 

time (Database services) 

2. High reliability   -  All data can be copied on two or three machines so if one of them is 
unavailable then the other two copies could be used 

3. Speed – Network provides a very rapid method for sharing and transferring files.  Without a 
network files are shared by coping them to flop disks, then carrying or sending the disk from one 
computer to another. 

4. Reduced cost:  Net workable versions of many popular software programs are available at 

considerable savings when compared to buying  

   individual licensed copies.  Bodies monetary saving, sharing a program on a network allows for easier 

upgrading of the program. 

 

5. Sending messages such electronic mail (E- mail).  The presence of a network provides the hardware 

necessary to install an E- mail    

    system.  E- Mail aids in personal and professional communication for all school personnel, and it 

facilitates the dissemination of general    

    information to the entire school staff.  Electronic mail on a LAN can enable students to communicate 

with teachers and peers at their own  

    school. If the LAN is connected to the internet, students can communicate with others throughout the 

world. 

 

6. Flexible access: School network for example:   allows students to access their files from computer 

throughout the school.  Students can  

    begin an assignment in their classroom, save part of it on a public access area of the network, and 

then go to the media center after school to  
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    finish their work.  Students can also work cooperating through the network. 

 

7. Communication :   A computer network can provide a powerful communication medium a long widely 

separated employees or individual (increase communication capabilities) 

Disadvantages of installing a Network 

1. Expensive to install:  Although a network will generally save money, our time , the initial cost of 
installation can be prohibitive ; cable , network cards and software are expensive and the 
installation may require the services of a technician. 

2. Requires administrative time.  Proper maintained of a network requires considerable time and 
expertise.  Many schools have installed a network, only to find that they did not budget for the 
necessary administrative support. 

3. File server may fail:   Although a file server is no more susceptible to failure than any other 
computer, when the files server “goes down” the entire network may come more to a 
halt.  When this happens , the entire school or company may lose access to necessary programs 
and file 

4. Cables may break:   Some of the configurations are designed to minimize the inconvenience of a 
Brocken cable, with other configurations; one Brocken cable can stop the entire network. 

What is Network interface card? 

•         A network interface card (NIC) is a device that plugs into a mother board and provides ports 
for the network media connections. 

•         It is the component that interface with the local – area network (LAN)  

Example of NETWORK DEVICE 

1)     Switch 

2)     Bridge 

3)     Server 

4)     Fiber optic cable 

5)     Hub 

6)     Router 

7)     Twisted cable 

8)     Coaxial cable 

9)     Repeater  
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IMPORTANCE OF NETWORK 

Network enable 

1)     Sharing of device   E.g.:  Network printer 

2)     Sharing  of information 

3)     Easy communication 

4)     Online shopping 

5)     Sim banking 

6)     Easy transfer of data through network device 

TYPES OF NETWORK 

1)     LAN 

2)     WAN 

3)     MAN 

4)     INTERNET 

5)     INTRANET  

HOME WORK 

Mention and explain network device according to their respective types of network 

i)   Switch is a computer networking device that links network to the respective type of network 

used is LAN 

ii)  Bridge is a network device that connects multiple network devices (LAN). 

iii)  Fiber optic cable is a cable containing one or more optic fibers to their respective network 

(internet). 

iv)  Server is large computer that stores websites on internet  

v)   Hub is a device for connecting multiple Ethernet devices together and making them acts as a 

single network segment + (LAN). 

vi)  Router is a device that is connected to two or more data for different network. (WAN) 
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vii)  Twisted cable:  is a type of wiring in which two conductors of a single circuit are together 

(LAN, MAN, WAN internet , intranet) 

viii) Coaxial cable is a type of cable that has an inner conductor surrounding by a tubular 

insulating layer, network. (LAN, WAN, MAN, Internet, Intranet) 

ix)    Repeater is a network device to regenerate or replicated a signal network used as (LAN, 

WAN, MAN, Internet, Intranet) 

Explain 5 types of network 

1)     LAN  - local – area network 

2)     WAN – Wide area network 

3)     MAN – Metropolitan area network 

4)     Internet – inter connected network world wide 

5)     Intranet - is the internal network of an organization which allows access to specific 

authorized users. 

NETWORK TOPOLOGY 

Is how device are connected in a given Network. 

TYPES 

1)     Logical 

2)     Physical 

THE ADVANTAGES OF NETWORKING 

•         Sharing of data 
•         Sharing of hardware e.g.; printer 
•         Easy transferring of data 
•         Easy communication 
•         Enable e- learning 
•         Enables e- commerce 
•         Exchange of information  

DISADVANTAGES OF NETWORKING 

•         Security of data 
•         Cost of installing nodes is very high 
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•         If server fails all the nodes will be affected 
•         Virus attack 

TYPES OF NETWORK 

•         LAN -  Local Area Network 
•         WAN  - Wide Area Network 
•         MAN – Metropolitan Area Network 

                   Area Network or sometimes Small Area Network 

•         Intranet 
•         Internet 

LAN-(Local Area Network) 

A LAN connects network device over a relatively short distance. A network office building, 

school, or home usually contains a few small LANS (perhaps one per room) and occasionally a 

LAN will span a group of nearly building. TCP/ IP net working LAN is often but not always 

implemented as a single IP sub-net. 

MAN – (Metropolitan Area Network)  

A large computer network which extends to a city or to large university campus is termed as 

metropolitan area network or MAN. 

The purpose of MAN is to provide the link to the internet in the long run.  A MAN usually in 

corporate a number of LANS to form a network. This large MANS backbone comprises of an 

optical fiber set up. 

What is WAN? 

As the name symbolizes Wide Area Network is a broad network whose communication is wider 

than the LAN, MAN, and CAN. 

The application of WAN (Wide Area Network) is not limited to a room, building of specific 

vicinity.  The basic purpose of WAN is to maintain a number of LAN network in order to 

increase the efficiency of the network. 

Different LAN network are connected to establish a network which will enable the user of one 

location to communicate with the users present in the other location.  Internet service provides 

usually help and guide to establish WAN (Wide Area Network) networks.  However many large 

organizations develop their own private WANs 

INTRANET 
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Is the internal network of an organization which allows access to specific authorized users 

ADVANTAGES 

1)     Intranet is free because it does not involve phone links 

2)     Easier updating 

DISADVANTAGE 

1)     Information cannot be shared outsides the local network  

EXTRANET 

Is a private network that extended to users outside the company usually via internet. 

ADVANTAGES  

1) Share of information between companies. 

2) Collaboration with other companies 

3) Communication between companies 

4) Jointly develop and use training programs with other companies 

DISADVANTAGES 

1) Expensive to implement 

2) Requires network security 

INTERNET 

Is an interconnected network worldwide. 

ADVANTAGES 

1) Sharing of information 

2) Data can easily update 

DISADVANTAGE 

1) Security of data 

2) Virus attack 
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THE NETWORK TOPOLOGY 

The network topology defined as layout of the network. 

Is the way in which nodes are connected in a network. 

NODES: are the network devices e.g.: Computer, switch, hub, server or router 

NODES can be connected physically or logically  

PHYSICAL TOPOLOGY  

Refers to the actual physical layout of the device in a network or the way in which in nodes are 

connected physically. 

LOGICAL TOPOLOGY  

Refers to the paths that signal from one point to the network to another. 

TYPES OF PHYSICAL TOPOLOGY 

•         BUS TOPOLOGY 
•         STAR TOPOLOGY 
•         RING TOPOLOGY 
•         HYBRID TOPOLOGY  

BUS TOPOLOGY 

Commonly referred to as linear bus all the device on a bus topology is connected by one single 

cable which from one computer to the next. 

This topology is rarely used and would only be suitable for a home office or small business with 

few hosts. 
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ADVANTAGES 

-          The thin net cabling it uses is quite inexpensive 

-          It uses less cable compared to other physical topologies like star or extended star 

-          It work well for small network 

-          It doesn’t need a central device such as hub , switch or route 

DISADVANTAGES 

-          It results in slower access to the network and less bandwidth due to the sharing of the 

some cable by all devices. 

-           It is challenging to identify and isolate problems 

-          A break at any point in the bus can disable the entire bus network 

-          It needs termination.  

STAR TOPOLOGY 

All nodes are connected to a central device. 

 

 

ADVANTAGES 

-          It is upgradable flexible and reliable 
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-          It is easy to design and install 

-          This topology makes diagnosing problem relatively easy since the problem is localized to 

one computer or device. 

-          This topology allows for more throughout than any other topology. 

DISADVANTAGES 

-          It requires a lot of cable to connect computer since a cable is required between each 

device and the central location. 

-          It is more expensive to build because of the additional cost of cables and devices like hubs 

and switches that one needed to run     

           between. 

RING TOPOLOGY 

Nodes are connected in a circle where by all device have equal importance. 

•         A frame called token, travels around the ring and stops at each node. 
•         If a node wants to transmit data , it adds that data and the addressing information to the 

frame. 
•         The frame continues around the ring until it finds the destination node which takes the data 

out of the frame. 

 
 

Advantages of Ring topology 

(i)Growth of system has minimal impact on performance 

(ii)All stations have equal access 

(iii)No one computer monopolize the network 
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Disadvantages of Ring topology 

(i)Most expensive topology. 

(ii)Failure of one computer may impact others. 

(iii)Complex in configuration. 

(iv)Difficult to troubleshoot a ring network. 

(v)Adding or removing computer disrupts the network. 

 

TYPES OF RING TOPOLOGY  

1)     Single ring topology 

The entire device on the network shares a single cable, and the data travels in one direction only. 

2)     Dual ring topology 

•         Two rings allows data to be sent both directions 
•         This creates redundancy (fault tolerance) meaning that in the event of a failure of one ring, 

data will still be transmitted on the other ring. 

ADVANTAGES OF RING TOPOLOGY  

•         Very fast because flow in one direction 
•         Less expensive than star topology 

DISADVANTAGES 

•         If one node fail will affect whole network  

MESH TOPOLOGY 

•         The mesh topology connects all devices (nodes) to each other for redundancy and fault 
tolerance. 

•         It used in WANs to interconnected LANs and critical Networks. 
•         The mesh topology is expensive and difficult to implement. 

ADVANTAGES 

•         Redundancy 
•         Fault tolerance 

DISADVANTAGES 

•         More cable needed 
•         It’s  very expensive 
•         Needs more skills 
•         Difficult to implement 
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HYBRID TOPOLOGY 

Combines more than one type of topology. 

ADVANTAGES  

•         Redundancy 
•         Fault tolerance 
•         Efficient 
•         High speed. 

DISADVANTAGE 

•         More cable are needed 
•         More complicated 
•         It’s very expensive 
•         Difficult to implement 
•             Hard to troubleshoot 

 

  

  

 

TOPIC:4 THE INTERNET 

What is internet?  

Internet is a wide world connection of computer which enables sharing of resources like files and folders, pictures 

and music, teaching materials like notes/ tutorials and computers. 

Communication between networks is called inter networking.  Therefore, internet comes from the word inter 

networking meaning a connection of data communication.  The communication in which the end instruments are 

computers. 

The internet is a worldwide public networks that interconnect thousands of smaller networks to form one large 

“web” of communication. Many private networks, some with thousands of users of their own connect to the internet 

by using the services of internet services providers (ISPs) 

In simple words internet is a huge number of computers that are connected to each other throughout the world. 

These computers are situated in many different countries and are connected through telephone lines, cables in the 

ground and even satellite in spaces. 

DEVELOPMENT OF INTERNET 
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Internet involved from US Department of defense project called ARPANET (Advanced Research Project Agency 

Network) in 1969. The main reason was to exchange information between researchers in this project 

Browses and World Wide Web (WWW) were introduced in early 1990’s. 

Using the internet: 

 (i)Why people use internet? 

 To find general information about the subject: 

 The web is like a huge encyclopedia of information, in some ways it’s even better. The volume of information you 

will find on the web is amazing. For every topic that you’ve wondered about it. The web offers many different 

perspectives on a single topic 

 To find information not easily available elsewhere: 

 It put information into your hand s that you might otherwise have to pay for or find out by less convenient means. 

 To correspond with faraway friends: 

 Email offers a cheap and easy alternative to traditional methods of correspondence. Its faster and easier than writing 

snail mail and cheaper than using telephone. 

 To meet People: 

 People love getting e-mail from strangers and friendship are quick to from casual correspondence. Many people 

have even found love on the Net, and have gone on to marry their cyber-partner. 

 To Discus: 

 To discuss their interests with like-minded people 

 To have fun: 

There’s plenty to keep you occupied on a rainy day. 

To learn: 

Online distance education courses can give you an opportunity to gain a qualification over the internet. 

To read the news: 

People all over the world access news through internet. For example a Tanzania who is living in London can be able 

to read Tanzania news paper on the paper on internet and be updated with Tanzania every day. 

To find Software: 

The internet contains a wealth of useful downloadable shareware. Some pieces of shareware are limited versions of 

the full piece of software, other are limited trial (you should pay once the time limit is up).Other share ware is free 

for educational institutions or non-commercial purpose. 
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To buy things: 

The securities online shopping is still questionable, but as well as you are dealing with a reputable company or web 

sites the risks are minimal. 

(ii)Why do people put things on the web? 

-To advertise a product 

-To sell a product 

-To make money 

-To share their knowledge with world 

The application of internet: 

Electronic mail (e-mail or email) is a store and forward method of composing, sending, storing and receiving 

messages over electronic communication systems. 

What makes internet different? 

(i)This is an electronic communication 

(ii)Its speed and broadcasting ability is fundamentally different from paper-based communication. This is because 

turnaround time can be so fast-mail is is more conversational than traditional paper-based media. 

Computer on the internet may use the following internet services 

 -   Electronic mail (e-mail) to send and receive mail 

 -   Telnet or remote log in to log  onto another computer and use it as if you were there 

 -   File Transfer Protocol (FTP) to rapidly download complex files intact from  a remote computer to local computer 

or upload from local computer to remote computer 

 -   Web 

 -   Social networks (face Book, twitter , linked in) 

 -   Online shaping 

 -   Search 

 -   Resources distribution (hosting ) 

 -   Video conferencing 

 -   Games 

Terms used in internet 
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WWW (World Wide Web) 

 

Web: Is the collection of websites on the internet 

 

Website: Is collection of Web Pages linked to each other. 

 

Web page: Is a single page on a website. 

 

Homepage: The first page of a particular website. 

 

Web browser: Software that enables user to retrieve and view HTML documents 

E.g. Internet explorer, safari, Mosaic, Netscape navigator 

Web Server: Large computer that stores websites on the internet. 

Hyper text: The document that contain hyperlink 

Hyperlink: The shortcut from one webpage to other web pages. 

HTML (Hyper Text Markup Language): Computer language used to make web pages. 

URL (Uniform Resources Locator): This is the address of website in the internet 

On Line: Connected to the internet 

Off Line: Not connected to internet; E.g. Http.www.Sir Patrick.com. 

PARTS OF URL 

1) Protocol 

2) Web 

3) Host 

4) Domain 

http://www.sirpatrick.com 

1       2       3          4 

HTTP-Hypertext transfer protocol 

IP-Internet Protocol 

POP-Pointing information Protocol 

ISP-Internet Service Provider 

PROTOCAL: Is a set of predetermined rules used to facilitate communication over data networks. 
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IMPORTANCE 

i) Used to allow device to communicate successfully. 

ii) Provide structure and format of the message 

iii) To set up and terminate the data transfer session 

SEARCH ENGINE 

Is the website that helps user to find information/material on internet E.g. Google,Yahoo!, Go,Mamma,Meta 

crawler,Lycos etc. 

TYPES 

1.INDIVIDUAL 

2.META 

E-MAIL ADDRESS: 

E-mail address is string that identifies a user so that a user can receive Internet e-mail. 

They are composed of: 

             -User ID 

             -The Symbol@ 

               -Domain name 

The domain: 

               -It is located after @ 

               -Tells the location and types of address 

               -Provides information about where the message should be delivered 

Root Domain: 

Describes the type of location; currently there six root domain 

(i).com: commercial organization 

(ii).edu: education /research organization 

(iii).go: government organization 

(iv).mil: military organization 

(v).net: gateway host network 

(vi).org: non profit or miscellaneous organization 
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Some domain name will also include the country name e.g.uk: England or tz: Tanzania 

Examples of e-mailaddressare: 

(a)janetjackson@yahoo.com 

                                       User ID: janetjackson 

                                      Domain name: yahoo.com 

                                       Domain (location): yahoo 

(b)pavinistanley@udsm.edu.tz 

                                       User ID: pavinstanley 

                                      Domain name: udism.edu.tz 

                                       Domain (location): udsm 

                                      Root domain (domain type): edu 

                                       Country: tz 

Advantages of E-mail 

(i)Convenience: there are no trips to the post office, no needs to search for stationary and stamps. A message can be 

formal or informal. It makes very easily to publish and discuss. 

(ii)Speed: e-mail is very fast. 

(iii)In expensive: Once you are online the cost of sending a message is small 

(iv)Printable: the hard copy is easily to obtain you may save on natural resources for your own records 

(v)Reliable: although messages occasionally lost, these are rare. Many mail systems will notify the sender if an 

email message was undelivered. 

(vi)Generality: it is not limited to texts; it allows the transfer of of graphics, programs and even sounds. 

 

 

Electronic Learning (E-Learning) 

E- Learning is the effective teaching and learning by using electronic media. 

E – Learning can occur in or out of the classroom.  E – Learning is suited to distance learning 

and flexible learning.  But it can also be used in conjunction of face to face teaching. 

Advantages of e- learning 

-  Reduce traveling costs and time to and from school 
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-  Learners can study whenever they access computer and internet 

-  Self – paced learning models allows learners to work on their own paces 

-  Class work can be schedule around personal and professional work, resulting in flexibility 

learning. 

Disadvantages of e – learning 

 

-Students may feel isolated or miss social interaction. 

-  Un motivated learners or those with poor study habits many fall behind 

-Istruction may not always be available on demand 

-  Slow or unreliable internet may be frustrating 

-Slow or unreliable internet connections can be frustrating  

-  Some courses such as traditional hands – on curses can be difficult to stimulate  

E – Commerce 

The buying and selling of products and services by businessmen and consumers through an 

electronic medium without using any paper documents. 

E – Commerce is widely considered the buying and selling of products over the internet, but any 

transaction that is completed solely through electronic measures can be consider e – commerce 

Advantages of e- commerce 

-   Faster buying and selling procedures as well as easy to find products 

-   Buying / selling 

-   More reach to customers, there is no the retinal geographic limitation 

-   Lower operational costs and better equality of services 

-   No need of physical company set ups 

-   Easy to start and manage a business 

-   Customers can easily select products from different providers without moving around 

physically  

 

Disadvantages 

-Perishable goods:Goods bought and sold via the internet tend to be durable and non perishable. 

-Lack of personal service:Although some human interaction can be facilitated via web e-
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commerce cannot provide the richness of interaction provided by personal service. 

-Security:Security of data moved across some mobile and wireless network participants. 

 

TYPES 

-Business-to-Consumer (B2C) 

-Consumer-to-Consumer(C2C) 

-Business-to-Business (B2B) 

 

Negative effects of internet 

Cultural Issues 

Information presented in the internet should careful consider the audience and not offended 

because of the cultural believes.Pornographic materials are offensive to most African cultures 

and other cultures distaste particular way of dressing which may potrey an image which is not 

necessarily what the dissemination of information had in mind. 

 

Religious  

In some religion rituals and symbols are serious matter to temper with.The information that 

involve those symbols or rituals must be careful treated to avoid disharmony in the concerned 

audience. Other religions,their important consideration in disseminating information are dressing 

code and place of worship.But internet do not take care about the effect of audience. 

 

Political 

Politics issues can affect information from the internet is political affiliation can affect proper 

dissemination of information as the information being biased to favor certain political  views. 

 

Social 

When information is corrupted from predators (internet),they mislead and bring confusion to the 

audience e.g. in a children social network,the appropriate information to the particular age is 

useful.Also other societies have certain agreed code of conduct which have a certain agreed code 

of conduct  which have a particular information expectation so the internet information is 

advised to be highly important to ensure expected ethical code of conduct by the audience 

observation.         

 

 

Download this and more free notes and revision resources from https://teacher.ac/tanzania/




